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Brief Description 

The LoggerSoft software is designed to work with data loggers with battery.  
With LoggerSoft a user can configure loggers, read event logs and archives, view and analyze 

data, and print reports. All data that have been read from the data loggers are stored in the database 
and are available for viewing and analysis at any time. 

LoggerSoft has flexible differentiation of user access rights. Available simultaneous data access 
for multiple users on the local network.  

LoggerSoft Software is free and available for download on the website http://ao-tera.com.ua/. 
This document is a complete user manual. It contains information on installing, configuring and 

using LoggerSoft software. It’s recommended to review this document when getting started with the 
software.  

System requirements:  
o Windows 2000/XP/2003/Vista/7/8  
o Processor 1 GHz 
o Memory 512 MB RAM 
o Free hard disk: 50 MB (for program files) 
o Free hard disk: 4 GB (for database)1 
o Protocol TCP/IP 
o Printer for reports 

                                                 
1 Database size depends on many factors such as the number of used data loggers, data archiving period, data 
hold time, etc. As soon as LoggerSoft is installed, database size is very small, but over time the file will grow. 
Depending on the intensity of program use, database file size can reach a lot more than indicated in this manual. 
 

http://ao-tera.com.ua/product_list/ru/loggersoft.html
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Installation 

General Information and Recommendations  

LoggerSoft software consists of client software with a graphical user interface (LoggerSoft), and 
database management system (DBMS), namely an open source Firebird DBMS (Firebird). 

The installation is done in two stages: 
1. Firebird installation  
2. LoggerSoft installation. 
 
ATTENTION! It is recommended to install software in this order: first, Firebird, then LoggerSoft. 
Depending on the need, both programs can be installed either on the same computer or on 

different computers in a local network. Client software can be installed on multiple computers depending 
on the number of operators. 

 
ATTENTION! Installation of LoggerSoft requires administrator rights. 

Installation Pack Overview  

A list of folders and files of LoggerSoft installation pack is shown in Figure 1 and described in 
Table 1. 

 

 
Figure 1. Overvire of LoggerSoft Installation Pack 

 
Table 1. A list of folders and files of LoggerSoft installation pack 
Drivers Folder with drivers  
Firebird Folder with Firebird installation files 
InstallDBHelper Folder with database template and Firebird configuration wizard 
LS Folder with LoggerSoft installation files 
Manual Folder with program documentation 
setup.bat Batch file, with the help of which you can run the startup disk interface 
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setup.dbd 
setup.txt 
run.exe 
autorun.inf 

Other files needed for startup disk interface. 

Interface Startup of Installation Disk 

The installation is recommended to perform via interface startup of installation disk (see Figure 
3). To access this interface, run setup.bat batch file which is in the root of the installation pack (see 
Figure 1).  

 

 
Figure 2. Startup disk interface (Language)  

 
Startup interface begins with language selection (see Figure 2). Select your language from the list 

and click "OK". The Main Menu will open. 
 

 
Figure 3. Startup disk interface (Main Menu) 
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Menu interface consists of a few options. Their description is presented in Table 2. 
 

Table 2. Menu of startup disk interface 
Install Goes to the Install Submenu 
Browse Opens the installation pack folder in Windows Explorer 
Our site Opens TERA’s website in a browser 
Contacts Shows TERA’s contact details 
Quit Closes startup interface 

 
To start the installation, choose the Install option which opens the Install Submenu (Figure 4). 

This menu contains two items: Firebird and LoggerSoft. Each of them corresponds to one of the 
programs, and starts installing the program. 

 

 
Figure 4. Interface startup disk (Install Submenu) 

Firebird 

Firebird should be installed on a PC with a reliable hard drive. This computer will store the file 
database. 

After starting the Firebird installation, the following dialog box will appear. Select the language 
when prompted for a language selection (Figure 5).  
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Figure 5. Installing Firebird - Select Language 

 
The Welcome to the Firebird Setup Wizard window will appear (Figure 6). This is the first step 

of the installation. Click Next. 
 

 
Figure 6. Installing Firebird - Step 1 

 
The License Agreement is Step 2 (Figure 7). Choose I accept the agreement and click Next. 
 

 
Figure 7. Installing Firebird - Step 2 
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In Step 3 the information about installation is provided (Figure 8). To continue, click Next. 
 

 
Figure 8. Installing Firebird - Step 3 

 
The next step provides a choice of installation directory (Figure 9). In most cases there is no need 

to change it. Simply click Next. 
 

 
Figure 9. Installing Firebird - Step 4 

 
Step 5 allows you to choose which program components to install (Figure 10).  By default this is a 

full install version and Super Server binaries. In most cases, this is the best choice. However, if you are 
not connected to the local network, it makes sense to choose Classic Server binaries. In this case, the 
database will work more efficiently. Click Next to move to another step. 
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Figure 10. Installing Firebird - Step 5 

 
Step 6 allows you to select a folder in the Start Menu to place the shortcuts (Figure 11). Name, 

which is offered by default, is quite acceptable. To continue, click Next. 
 

 
Figure 11. Installing Firebird - Step 6 

 
Step 7 is the choice of additional post-installation tasks (Figure 12).  All necessary parameters 

are selected by default. To change anything is not necessary. Just click Next. 
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Figure 12. Installing Firebird - Step 7 

 
Step 8 is the page which shows all the selected installation options (Figure 13). If there was a 

mistake somewhere in your choice, you can go back to that page and fix it. If everything is correct, then 
click Install to start the installation process. 

 

 
Figure 13. Installing Firebird - Step 8 

 
Step 9 offers to review the information for your Firebird (Figure 14). To continue, click Next. 
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Figure 14. Installing Firebird - Step 9 

 
Step 10 is the final step of installation (Figure 15). It displays information about the installation 

and offers two tasks to perform after the wizard has been completed. Check Start Firebird Service 
now? box and uncheck After installation - What Next? box. To complete the wizard, click the Finish 
button. 

 

 
Figure 15. Installing Firebird - Step 10 

 
The Firebird is now installed on your PC. 

Firebird Configuration Wizard for LoggerSoft 

For LoggerSoft operation, it is necessary to create the database and configure Firebird. To 
facilitate this process, Firebird Configuration Wizard program is used (Figure 16). This program is 
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launched automatically after the Firebird has been installed, if Firebird installation was launched via 
startup disk. 

If the wizard does not start automatically, it must be run manually. To do this, open the folder in 
the InstallDBHelper root directory and double-click the idh.exe. 

The Wizard creates the necessary databases and configures Firebird to operate with them. 
The upper part of the Wizard window displays the Firebird state. If the server is OK, the green 

LED labeled OK lights (Figure 16). If there is a problem with the server, the red LED labeled ERROR 
lights (Figure 17). In this case, you should pay attention to the message and fix the problem.  

 

 
Figure 16. Firebird Configuration Wizard  

 
In the central part of the wizard the user specifies the folder for the database files. By default, it is 

Databases folder on the D: drive. Optionally, you can specify a different folder, however, it is strongly 
recommended not to choose a folder on the C: drive (system drive). As when reinstalling the operating 
system, most likely, these files will be lost. 

 

 
Figure 17. Firebird Configuration Wizard (ERROR) 

 
To make the Wizard perform all the necessary actions, click OK. The installation progress will be 

displayed in the bottom part of the window. After that the Finish button will appear. Click it to complete 
the Wizard. 

If there is the LoggersDB.FDB  database file in the specified folder, it shows the correct Wizard 
operation.  
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LoggerSoft 

The LoggerSoft is client application for working with the file database in a user-friendly interface. 
The program is installed on a PC. 

To install the LoggerSoft, first select the language and click OK (Figure 18). 
 

 
Figure 18. Installing LoggerSoft - Select the language  

 
After that the Welcome Wizard window opens (Figure 19). This is the first step of the installation. 

Click the Next button. 
 

 
Figure 19. Installing LoggerSoft – Step 1  

 
Step 2 chooses a destination folder (Figure 20). By default, it is installed in the folder C:\Program 

Files\TERA\LoggerSoft. In most cases, there is no need to change the destination folder, however, if 
you still want to do it, click Change… To continue, click Next. 
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Figure 20. Installing LoggerSoft – Step 2  

 
Step 3 is overview of the selected installation options (Figure 21). If there is a mistake, go back to 

the previous step by clicking the Back button and correct it. To start the installation process, click Install. 
 

 
Figure 21. Installing LoggerSoft – step 3 

 
Step 4 shows the results of installation (Figure 22). Click Finish to complete the installation. 
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Figure 22. Installing LoggerSoft – Step 4 
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Description of LoggerSoft Interface 

The main program window of LoggerSoft is shown in Figure 23. It is possible to identify eight 
major panels: 

1. Main Menu Bar 
2. Standard Toolbar   
3. Loggers and Labels Panels 
4. Recorded Data Control Panel 
5. Data Display Area 
6. Downloaded Data Panel 
7. Log Output Panel 
8. Status bar 

 

Figure 23. The main program window of LoggerSoft 

Main Menu Bar 

File Menu 
Table 3. File Menu Options 

Option Description 
Print… Opens a standard print dialog box 
Print Preview Opens print preview 
Print Setup… Opens a standard print setup dialog box 
Exit Closes the program 
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User Menu  
Table 4. User Menu Options 

Option Description 
Login Opens a login dialog box 
Logout Logs the current user out of the program 
Change Password Changes the password of the current user 

View Menu 
Table 5. View Menu Options  

Option Description 

Toolbars and Docking 
Windows 

Contains a dropdown menu with a list of toolbars and docking windows that 
can be hidden: 
 Standard 
 Data Loggers View 
 Labels View 
 Output 

Options in this menu hide/open the relevant panels or windows 
Graph Presents data in a graph 
Table Presents data in a table 
Device Event Log Opens the data logger Event Log 
Report Presents data in a report 
Status Bar Hides/Opens Status bar 

Connected Devices Menu 
This menu changes dynamically depending on the connected devices. If no devices connected, 

the menu contains options presented in Table 6. If one device is connected, the menu is completed by 
the options from Table 7. If multiple devices are connected, a dropdown menu with options in Table 7 is 
created for each of devices. 

 
Table 6. Connected Devices Menu Options 

Option Description 
Search for Connected 
Devices 

Starts a search for connected devices 

 
Table 7. Options to Work With Device   

Option Description 
Download Data… Opens a dialog box for downloading data from a device 
Settings… Opens a device configuration dialog box  
Time Synchronization Synchronizes a device and computer time 
Battery Replacement… Replaces a device battery 
Clock Calibration… Calibrates a device clock 
Calibration of 
Measurement 
Channels… 

Opens a dialog box for calibrating measurement channels 

Tools Menu 
Table 8. Tools Menu Options  

Option Description 
User Event Log Opens a user Event Log 
Search for Connected 
Devices 

Starts a search for connected devices 

Settings Menu 
Table 9. Settings Menu Options 
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Option Description 
Database… Opens a dialog box of database settings 
User Rights… Opens a dialog box of administrative user rights 
Supported Device 
Types… 

Displays a list of supported device types 

Language Shows a dropdown menu with a list of available interface languages 

Help Menu  
Table 10. Help Menu Option 

Option Description 
About LoggerSoft… Displays information about the LoggerSoft software 

Standard Toolbar 

The Standard Toolbar duplicates some of the options of the main menu bar for quick access. A 
list of these options is shown in Table 11. 

 
Table 11. Standard Toolbar Options 
Button Option Description 

 Print… Opens a standard print dialog box 

 Entry Opens a dialog box of user login 

 Exit Logs a current user out of the program 

 Search for Connected Devices Starts searching for connected devices  

 Download Data… Opens a dialog box for downloading data from a device 

 Graph Presents data in a graph 

 Table Presents data in a table 

 Logger Event Log  Opens a logger Event Log 

 Report Presents data in a report 

 About LoggerSoft… Displays information about the LoggerSoft software. 
 
If the current panel is disabled, open it again via View → Toolbars and Docking Windows 

→Standard. 

Data Loggers View and Labels View Panels 

Both panels display a list of data loggers which are in the database, but with a different method of 
sorting. The Data Loggers View panel focuses on sorting and searching a data logger by its serial 
number. The Labels View panel is designed to display data loggers sorted by their text label. Both 
panels indicate a serial number and a text label in separate columns. You can change the sort direction 
by clicking on the header of the columns. 

If the panels are disabled, open them again via View → Toolbars and Docking Windows → 
Data Loggers View / Labels View. 

To view the recorded data, double left-click the data logger in the list of any of these panels. The 
data of the selected data logger will appear on the Recorded Data Control panel.  

Right-click the item in the list to open its context menu. There are context menus of data loggers 
and text labels there.  
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Data Logger Context Menu  
This context menu appears by right-clicking the data logger item in the Label and Loggers 

panels. List of options in this menu is shown in Table 12. 
 

Table 12. Data Logger Context Menu Options 
Option Description 

Download Data... Opens a dialog box for downloading data from a device 
Settings… Opens a device configuration dialog box 
Time Synchronization Synchronizes a device and computer time 
List of Logical 
Parameters… 

Opens a window with the list of logical device parameters 

Battery Replacement… Replaces a device battery 
Clock Calibration… Calibrates a device clock 
Calibration of 
Measurement 
Channels… 

Opens a dialog box for calibrating measurement channels 

Delete 
Deletes the selected data logger from the database.  
NOTE. It is forbidden to remove the data logger which is currently connected 
to the PC.  

Text Label Context Menu 
This context menu appears by right-clicking the text label item in the Label panel. List of options 

in this menu is shown in Table 13. 
 

Table 13. Text Label Context Menu Options 
Option Description 

Create Creates a new text label 

Delete 
Deletes the selected text label from the database 
NOTE.  It is forbidden to delete both the text label connected to the logger 
and <No labels> item. 

Recorded Data Control Panel 

This panel is designed to view the recorded data in the database. The example of the panel is 
shown in Figure 24. 

 
Figure 24. Recorded Data Control Panel 

 
The Logger section displays information about the data logger, which is selected for viewing, 

namely, its serial number and text label. 
The Period section contains the control elements for selecting the time period to view the data. 
The Load button initiates the data loading for a specified time interval from the database. Both 

the recorded data and the Event Log of the selected data logger are downloaded. Download process is 
displayed in the status bar. After the process is completed, the data will be displayed in the Data Display 
Area in the form that is currently selected. 

The Abort button interrupts the download process. 
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Data Display Area 

This is the window which displays the data downloaded from the database. Such data can be 
presented in several forms, namely in the form of a graph, a table or a record. Also, this window displays 
the data logger Event Log. Choose the type of information view by using the options of View menu or by 
pressing the buttons of the Standard toolbar.  

Graph 

The graph shows how the parameters change during the specified time. The graph example is 
shown in Figure 25. 

Figure 25. Graph Example 
  

The symbols area shows the names of data logger logical parameters with reference to the color 
of the pen, with which a graph of this parameter is drawn. If hover the mouse over the symbols area, the 
>> pop-up button will appear. Click it to open the checkboxes of displaying channels. If uncheck the 
checkbox, the graph of the appropriate channel will not be displayed (see Figure 26). 

 
Figure 26. Symbols Area 

 
The graph always contains one X-axis, the axis of time. There can be several axes, depending on 

the number of different units of measurement which are used by the data logger. 
Each axis can operate either in the auto scale or specified scale mode. By default, the auto scale 

mode is used. To change the axis scale, drag the axis by left-clicking up or down. If pulling up, the scale 
increases. If pulling down, the scale decreases. To return to the auto scale mode, hover over the axis 
and click the Auto Zoom pop-up button.  

It is also possible to zoom in any part of the graph for more detailed viewing with the help of the 
mouse. Hold down the left mouse button while dragging out the area of interest from left to right, and 
then release the button. After that, the selected area will be extended to the whole screen of the graph. 
To zoom out, stretch the frame from right to left. In addition, it is possible to change the scale using the 
mouse wheel (the third mouse button). 

It is possible to move the graph using the right mouse button. In this case, if the cursor is over a 
graph area, the graph will be moved on all axes simultaneously. If the cursor is over the particular axis, 
the graph will be moved on this axis. 

After each graph moving or axis zoom, the Restore button appears in the bottom of the graph. 
Click on this button to return to the initial position.  
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Figure 27. Time Axis Context Menu 

 
Date format on the time axis can be changed so that it was the most informative. To do this, right-

click the context menu on the time axis and choose the desired format (see Figure 27). 

Figure 28. Cursor on the Graph 

For a detailed analysis of the data it is possible to set the cursor by double clicking on the graph 
(Figure 28). The cursor is a vertical line with a time label and small windows, which contain the values 
per each channel at this time. Windows with values can be moved with the mouse. 

The cursor can be moved left/right with the mouse. To move the cursor, click the context menu 
over it and select Remove the cursor. 

Table 
Presenting information in tabular form also allows tracking the changes of the parameters. 
Table columns are logger measurement channels, and table lines are channel parameter values 

at certain times. The left column contains date and time of each row. The column headings contain the 
names of logical parameters and their measuring units. The table example is shown in Figure 29. 
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Figure 29. Table Example  

 
This table can be exported to the file (please refer to Data Export). 

Logger Event Log 
Data logger Event Log allows to answer some questions in situations when no graph, no table 

can give the full picture. Also, the Event Log provides explanations in case of failures. If it is necessary to 
know the exact time of the event, the Event Log should be used. 

The Event Log example is shown in Figure 30. List of events is presented in tabular form. The 
table has two columns. The left column contains date and time of events. The right column contains a 
text description of the event. 

 

  
Figure 30. Event Log Example 

 
This table can be exported to the file (please refer to Data Export). 

Report 
Before printing, view the format and content of the report. If necessary, the format can be 

changed. The report example is shown in Figure 31. The report consists of a header, a summary data 
table, a recorded data table and a graph. The report header specifies the data logger text label and serial 
number, the beginning and the end of the reporting interval, and logging period. 

When viewing the report, the Report Options toolbar opens to the left of the report. The panel 
has control elements for changing the report format. 

The Page Setup... button opens a dialog box for editing the parameters of the report page (see 
Figure 32).  

The Included in the Report section contains checkboxes: Table, Event Log and Graph. 
The Channels section contains a list of checkboxes of measurement channels. 
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Figure 31. Report Example 
 
The Page Setup dialog box allows changing the page orientation and reporting margins (Figure 

32). 

 
Figure 32. Page Parameters 

 

Downloaded Data Panel 

This panel is presented on the screen if graph, table or device Event Log is selected for 
displaying the data (Figure 33). If report is selected, this panel is hidden.  



   LoggerSoft 26 

Panel provides information in the form of a summary table based on data that is loaded from the 
database at the moment. Table rows are data logger measurement channels. The columns are: unit, 
minimum, maximum and average. 

 

Figure 33. Downloaded Data Panel  
 

Log Output Panel 

This panel displays the program Log. It is a text file which is located in the program folder. 
Recording to the file is duplicated on-screen. 

The program Log can be useful for analyzing the causes of errors or the results of user actions. It 
contains details of user operations. 

If this panel is hidden, open it again via View → Toolbars and Docking Windows → Output. 

Status Bar 

The status bar at the bottom of the program window contains information about the state of the 
program. The status bar is divided into several sections (left to right): 

o current status or tip about the menu command  
o long-acting process indicator 
o current user name 
o database connection indicator 
o connected devices indicator 
Depending on the specific situation, other information may additionally be displayed in the status 

bar. 
When hovering over the individual sections of the status bar, tooltips containing more detailed 

information appear. 
If there is no connection with database, left double-click the indicator to reconnect. The dialog box 

will display the list of connected devices.  
If the status bar is disabled, open it again via View → Status Bar. 
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Working With LoggerSoft 

Starting the Software 

To start the LoggerSoft software, use the LoggerSoft shortcut on the desktop or via Start → All 
Programs → TERA → LoggerSoft → LoggerSoft. After starting the main window opens (see Figure 
23). 

When the user first start the program, he may see a message saying that he cannot connect to 
the database. In the status bar the database connection indicator will be red. This situation can occur in 
two cases. First, if the database (Firebird) is on the same computer as the LoggerSoft program, but it is 
not yet installed, configured or launched. In this case, it is necessary to install, configure or launch 
Firebird (please refer to Firebird and Firebird Configuration Wizard for LoggerSoft paragraphs). 
Second, if the database is on another computer. In this case, check and change the database settings 
(please refer to Database paragraph). Once the connection with the database is restored, the indicator 
in the status bar turns green and loads a list of loggers that are in the database. 

The program is ready to be used. You can perform a number of actions that do not require 
authorization, such as search for connected devices, download data from a data logger, view the 
downloaded data, print reports, view current data logger settings. To perform other actions, such as 
change settings of a data logger or a program, remove loggers from the database, etc., it is required to 
log into the program (please refer to User Login/Logout paragraph). 

User Login/Logout 

To enter the program, use the User → Login main menu. This command opens an authorization 
dialog box, shown in Figure 34. Enter login (or username) and password, then press the Enter button. If 
the data is entered correctly, the dialog closes and the status bar displays the name of the logged in 
user. 

 

 
Figure 34. User Login 

 
The User field on the dialogue is designed as a drop-down list. This makes it possible to enter a 

username from the keyboard or select it from the list. The list contains all the users which are in the 
database.  

 
NOTE. After the program is installed, there is only one user, Administrator. The password for 

this user is not specified. The user is used to administer the user rights and program settings. 
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WARNING! It is strongly recommended to change the password for the Administrator user 
to avoid unauthorized access to the database and malicious actions that can be performed even 
unintentionally. 

To exit the program, use User → Logout main menu. Once the user is logged out, the status 
bar indicates Login failed line.  

Changing the User Password 

Any user can change his password. Besides, the password of any user can be changed by a user 
with permissions of administration of user rights (please refer to Administration of user rights). 

To change his password, the user must log in to the program and use the User → Change 
Password command in the main menu. In response, the Authorization Check dialog box opens (Figure 
35). Enter the password and click OK. If the password is correct, the dialog box closes. 

 

 
Figure 35. Authorization Check 

 
If the user's authority is confirmed successfully, the Change Password dialog box opens (Figure 

36). 
 

 
Figure 36. Change Password 

 
Enter the new password twice and click OK. If the entered passwords match, the dialog box 

closes and the message about successful change of password appears. 
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Search for Connected Devices 

To configure a data logger or read the recorded data, it is necessary to establish communication 
with the data logger and synchronize it with the database. To do this, connect the logger to the PC and 
use the Search for connected devices command. Since this command is used frequently, it is 
duplicated in several places: 

o Connected devices main menu   
o Tools main menu 
o Standard toolbar  

 
When clicking the Search for connected devices command, the program will scan all COM 

ports that are in the system to determine the connected data loggers. If communication with the logger is 
installed, the program reads its basic parameters. Searching process is displayed in the status bar and in 
the window of the program Log. The program will inform about the search results with a message. Since 
all the ports are scanned, three variants of different messages are possible. 

If the connected devices are not found, the program will display the message shown in Figure 37. 
 

 
Figure 37. Report the results. Devices are not found  

 
If a data logger is connected, the program displays a message, an example of which is shown in  

Figure 38. 

 
Figure 38. Report the results. Found one device  

 
If several devices are connected, the program displays a message, an example of which is 

shown in Figure 39. 
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Figure 39. Report the results. Found several devices 

 
After communication with the logger is installed, the software synchronizes this logger with the 

database. The process is also displayed in the status bar and in the window of the Log program. In case 
of any errors, the program displays a message describing the error. 

After synchronization with the database, data logger settings and time are read. If the data logger 
time deviates from the computer time for more than 5 minutes, the program will ask to synchronize the 
time. The message will indicate the current logger time and the deviation from the computer time. The 
example of the message is shown in Figure 40. Click Yes to synchronize the time immediately. Click No 
to keep on working without time synchronization. In any case, time can be synchronized later using a 
special command (please refer to Time Synchronization paragraph). 

 

 
Figure 40. Request for logger time synchronization 

 
Once all the steps above are completed, the Connected Devices main men, the Connected 

Devices indicator in the status bar and the color of the logger icons on the Loggers and Labels 
panels will change.  

If multiple devices are connected, there will be a drop down Logger №N menu in the Connected 
Devices main menu for each device. N is a serial number of the data logger. If one device is connected, 
the Connected Devices menu will change to Logger №N, where N is the serial number of the data 
logger. If there were mistakes during synchronization, some options in the data logger menu will be 
unavailable. 

Depending on the search results, the Connected Devices indicator in the status bar will be 
either gray  (no connected devices) or green /  (connected single/multiple devices). 

On the Loggers and Labels Panels the color of the data logger icons which are connected and 
synchronized with the database will also change to green. If there were mistakes during synchronization 
with the database, the color of the icons remains blue. 
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List of connected devices and choice of the current device 

If more than one device is connected at a time, than one of them is current. All operations which 
are performed without specifying the default device are performed in relation to the current device. The 
example of such operation is reading data from the logger, launched by pressing the button on the 
Standard toolbar. 

To see a list of connected devices and a current device or select another current device, left 
double-click on the Connected Devices indicator in the status bar. As a result, a dialog box with a list 
of connected devices will appear (Figure 41). 

 

 
Figure 41. List of Connected Devices 

 
The current device is highlighted in the dialog box. To change the current device, select another 

device in the list and click OK. The dialog box will close and the current device will be changed. 
If the user with the rights to perform the factory setting logged in to the program, the Factory 

settings button will also be available in the dialog box. 

Downloading Data from a Device 

Since the command of downloading data from a device is used frequently, it is duplicated in 
several places: 

o Connected devices main menu   
o Standard toolbar  
o Loggers and Labels Panel context menu 
 
Download Data dialog box opens when selecting the command (Figure 42). The Logger section 

displays information about the data logger, which is selected for downloading, namely, its serial number 
and text label. The Period section contains the control elements for selecting the time period during 
which it is necessary to download the data. 

 
To start the process of downloading, click the Download button. The reading process can be 

prematurely interrupted. To do so, click Cancel. 
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Figure 42. Downloading Data 

 
Data downloading process consists of two alternate phases. First, the data is downloaded for a 

specified time interval, and then the data logger Event Log is downloaded. Download process is 
displayed in the status bar and on the process indicator. The details of operation can be found in the 
program Log. Downloaded data is stored in the database and from this moment available for viewing. 

 

 
Figure 43. Message about success data downloading  

 
After the data is read, the program will display the message shown in Figure 43. If you click OK, 

the message box and the Downloading Data dialog box will be closed, and the downloaded data will be 
displayed in the Data Display Area in the specified format. 

If there is an error during the downloading process, the program will display the message about it. 
It will be possible to see more information about the error in the program Log. 

Viewing the Downloaded Data 

Data that once was downloaded from a data logger and stored in a database is available for 
viewing and analysis at any time regardless of the availability of the data logger. 

To view the downloaded data, select the data logger on the Loggers or Labels Panels by left 
double-clicking. As a result, the Downloaded Data Panel will display the logger serial number and text 
label. Then select the downloading interval and click the Download button. This will start the process of 
downloading the data from the database. The process will be displayed in the status bar and in the 
program Log. At any time, the downloading process can be stopped by pressing the Abort button. After 
the download is complete, the data will be presented in the Data Display Area in the specified format. 



LoggerSoft 33 

The data is ready for viewing. If there is a need to change the data format, use View main menu or 
press Standard toolbar buttons.  

Printing a Graph 

To print a graph: 
1. Select a data logger, the graph of which should be printed. 
2. Download the data from the database for the specified time period (please refer to Viewing 

the Downloaded Data). 
3. Use the View → Graph command in the main menu. 
4. If preview is necessary, command File → Preview in the main menu. 
5. Command File → Print in the main menu. If this command is not active, left-click on the Data 

Display Area. As a result, a standard Print dialog box will open. To print, select the printer 
and click OK. 

Printing a Table 

Printing a table process is similar to printing a graph (please refer to Printing a Graph). 

Printing the Data Logger Event Log  

Printing the data logger Event Log is similar to printing a graph (please refer to Printing a 
Graph). 

Printing a Report 

A report example is presented on the Figure 44. 
To print a report: 
1 Select a data logger, the report of which should be printed.. 
2 Download the data from the database for the time period that corresponds to the reporting 

one (please refer to Viewing the Downloaded Data). 
3 Use the View → Report command in the main menu. 
4 If necessary, change the parameters of the report (please refer to Report). 
5 If preview is necessary, command File → Preview in the main menu. 
6 Command File → Print in the main menu. If this command is not active, left-click on the Data 

Display Area. As a result, a standard Print dialog box will open. To print, select the printer 
and click OK. 
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Figure 44. Report example 

 

User’s Event Log 

During the program operation, it records user’s actions in the user’s Event Log. The users with 
the appropriate rights can see the Event Log. 

To open the user’s Event Log (Figure 45), use the Tools → User’s Event Log command in the 
main menu. 
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Figure 45. User’s Event Log  
 
When opening the User’s Event Log, the list of events for the current day is automatically 

loaded. 
To see a list of events for a different period, specify the desired length of time in the Load Events 

section and then click Download. The time interval is selected as follows. First, select starting date and 
time, then select the time duration using the 1 Hour, 8 Hours, 12 Hours, 1 Day, 3 Days, 7 Days 
buttons. To see the list of events from the selected date and time to the present, press the All button. 

The following information is presented in the Log for each event: 
o Date and time of the event 
o The user who performed an action 
o The computer from which the action was committed 
o The type of action that has been performed 
o Text description of action 
 
There is a list of events in the Display Events section for filtering events. Changing the filter 

updates the list of events. To change the filter quickly, press the Select All or Deselect All buttons. 
The list of events can be sorted by any column of the table. To sort events, left-click on the 

column header. Another click on the header of the same column changes the sort direction. The column 
by which the list is sorted at the moment and the sort direction are indicated by a special marker. 

Some events may have long text descriptions. Therefore, to view detailed information about a 
single event left double-click on a line of interesting event. As a result, the event will be opened in a 
separate dialog box, an example of which is shown in Figure 46. 
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Figure 46. Overview of Event 

 
The user Event Log can be exported to the file (please refer to Data Export). 

Data Export 

LoggerSoft supports data export in the CSV. format1. The user can export any program table: the 
table of historical data, the table of data logger Event Log, the table of user Event Log. 

To export data, open the necessary table and right-click on it. In the context menu select Data 
Export in CSV Format and specify a file name to save.  

 

                                                 
1 CSV (Comma-Separated Values) — text format for presenting tabular data. Each file line is one row of the table. Values of 
separate columns are separated by delimiters.  
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LoggerSoft Settings 

Database 

The database coordinates are an IP-address or the name of computer which contains the 
database, and the name of the database itself. The database name is preinstalled and in most cases 
there is no need to change it. 

By default, the database coordinates indicate the local computer. If LoggerSoft and Firebird are 
installed on the same computer, the installation of database location is not required. 

To change the database settings, use the Settings → Database... command in the main menu. 
As a result, the Database Settings dialog box will open (Figure 47). Enter the coordinates of the 
database in the dialog. 

 
Figure 47. Database Settings 

 
In the Name or IP address of the computer field enter the name or IP-address of the computer 

on which Firebird is installed. Click Check Connection to verify that there is a communication with the 
specified database. If the check connection is successful, click OK. The program connects to the 
database and the green LED lights in the status bar. 

Administration of user rights  

LoggerSoft has a flexible system for allocating user rights. All users are divided into groups 
depending on the authority. Each group is assigned individual rights. The user who belongs to the group 
automatically receives all the rights of this group. The user may belong simultaneously to several groups, 
and thus he receives the rights of all groups. In addition, the user can assign additional personal rights 
(besides group rights). 

After the database is installed, there is only one user, Administrator. The password for this user 
is not specified. This user is a part of Administrators group, which has full rights. Accordingly, the 
Administrator user also has full rights, too. This user is used to administer the rights of users and 
program settings.  

WARNING! It is strongly recommended to change the password for the Administrator user 
to avoid unauthorized access to the database and malicious actions that can be performed even 
unintentionally. 

To administer user rights, log in to the program as the Administrator user (or another user with 
the same rights) and use the Settings → User Rights... command in the main menu. As a result, the 
Administration of user rights dialog box will open (Figure 48). 
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Figure 48. Administration of user rights 
 
There is a tree with a list of user groups in the left part of the dialog, and a tree with a list of users 

in the right part of the dialog.  
When opening the node of User Groups in the tree, the user can see two child nodes: Group 

Members and Group Rights. Group Members contains all users included in this group. Group Rights 
contains a list of actions allowed for this group. 

When opening the node of Users in the tree, the user can see two child nodes: Group 
Memberships and User Rights. Group Memberships contains a list of groups in which the user is a 
member. User Rights contains a list of actions that are permitted to the user in addition to the group 
rights. 

Three buttons are located under each tree. Their availability depends on which node in the tree is 
currently selected. All three buttons are active if the group node or user node is selected respectively in 
the tree. 

If the user presses the Create... or Edit... button under the User Groups tree, the Edit a User 
Group dialog box opens (see Figure 49) to create a new group or edit an existing one. If the user 
presses the Delete button, the program will ask to confirm deletion of the user group and in the case of 
confirmation, the group will be deleted. 

If the user presses the Create... or Edit... button under the Users tree, the Edit a User dialog 
box opens (see Figure 50) to create a new user or edit an existing one. If the user presses the Delete 
button, the program will ask to confirm deletion of the user and in the case of confirmation, the user will 
be deleted. 

NOTE. It is forbidden to delete the user who is logged in the program at the moment. 
The + and - buttons between the trees are used to add users to groups and delete users from the 

group, respectively. The activity of these buttons depends on which nodes are highlighted in the trees at 
the moment. 

If the user selects the Groups node on the left and the Users node on the right, the + button will 
be active. Clicking this button adds the selected user on the right to the group highlighted on the left.  
The program preliminary asks for confirmation. 

If the user opens the Group Members node and selects the user in the appearing list, the – 
button will be active. Clicking this button removes the user from the group. The program preliminary asks 
for confirmation. 
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Editing User Groups 
A user group is edited by using the dialog box which is shown in Figure 49. The title of the dialog 

specifies what action is being performed, either creating a new group or editing an existing one. 
 

  
Figure 49. Editing a User Group 

 
In the User Group Name section, enter the group name. 
The main part of the dialog box has two lists: List of unauthorized actions and List of allowed 

actions. The actions that need to be allowed for group should be moved to the list of allowed actions. To 
move actions from one list to another, use the buttons between the lists. The > and < buttons move only 
those actions that are selected at the moment. The >> and << move immediately all actions. Also the 
user can move an action from one list to another by left double-clicking on the action list. 

Click OK to save changes. Click Cancel to close the dialog box without saving changes. 

Editing Users 
Users are edited by using the dialog box, which is shown in Figure 50. The title of the dialog 

specifies what action is being performed: creating a new user or editing an existing one.  
In the User Data section, enter the user’s name and initials but the last name is the only required. 

Also there is the Set Password... or Change Password... button in this section depending on what 
action the dialog was opened for. 

If the dialog box is opened to create a new user, set a password for a new user by clicking the 
Set Password... button. It opens the Set Password button (Figure 36). 

If the dialog box is opened to edit an existing user, change the user’s password by clicking the 
Change Password... button. It opens Authorization Check button (Figure 35). For more information 
please refer to Changing the User Password. 
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Figure 50. Editing a User 

 
The dialog box also has two lists: List of unauthorized actions and List of allowed actions. If 

the user needs to set personal permissions, place the appropriate actions to the list of allowed actions. 
The actions are transferred between the lists in the same way as for a user group (please refer to 
Editing a User Group). 

Click OK to save changes. Click Cancel to close the dialog box without saving changes. 
 

 
Figure 51. Request for password setting  

 
If the dialog box was opened to create a new user but the password was not set, then when the 

changes are being saved, the program prompts to set a password (Figure 51). Click No to create a user 
without a password. Click Yes to set a password in the dialog box (Figure 36). 
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Supported Device Types 

Overview 
A device type is determined by a combination of device internal name and firmware. To work with 

any type of devices, the program needs a memory card and customized template of this type of device. 
The template can be created automatically on the base of the memory card. 

When connecting the unknown types of devices to the computer, the program automatically adds 
this type to database. If there is a memory card, the specification of variables is created for this type of 
device. The specification is automatically stored in the database.  

If there is no memory card, the program will not operate with devices of this type, and the 
message will display it. If the specification of variables is successfully created, the program automatically 
creates a template based on the specification. At the same time, the names of logical parameters will 
match the internal names of the corresponding variables. Thereafter, the program is ready to operate 
with devices of this type. 

When connecting a device which type and template are already in the database, to the computer, 
software will synchronize the device with the database. It will result in creation a device exemplar with 
reference to the device serial number and a list of exemplar logical parameters according to the 
template. 

The template which was created automatically is quite enough for operation, but for convenience, 
the user can change the names of logical parameters to more meaningful. To do this, it is possible to 
change the display name of the variables in the specification, the name of logical parameters in the 
template and the name of logical parameters of a particular device exemplar. 

List of Supported Device Types 
To check if the work is supported with some type of device or configure its template, use the 

Settings → Supported Device Types... command in the main menu. The List of Supported Device 
Types dialog box will open (Figure 52). 

 

 
Figure 52. List of Supported Device Types  

 
The list of supported devices is presented in tabular format. The device’s internal name, firmware 

version, specification of variables and template are indicated for each type of devices.  
To perform any action with the type of device, right-click on the line with the interested type of 

device to call a context menu (Figure 53). 
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Figure 53. Context menu of device type 

 
The Specification of Variables... command opens a window with a list of variables of this type of 

device. An example of this window is shown in Figure 54. If the database contains no specification of 
variables for this type of device, the program prompts the user to create a specification based on the 
memory card. 

The Edit Template... command opens a window with a list of logical parameters of this type of 
device. An example of this window is shown in Figure 56. If the template for this type of device is not in 
the database, the program will offer to create it based on the specification of variables. 

The Data Export in CSV Format command allows to export the list of supported device types in 
the file (please refer to Data Export)  

The Delete Specification of Variables command allows deleting the specification of variables of 
this type of devices. Before deleting, the program asks for confirmation. 

NOTE. The specification is deleted simultaneously with the template. So if there is a template in 
the database, the program requests additional confirmation to delete the template. 

The Delete Template command deletes a template of this type of device. Before deleting the 
program asks for confirmation.  

The Delete Device Type command allows deleting a type of devices from the database together 
with the specification of variables and template. Before deleting, the program asks for confirmation. 

WARNING! If the database contains devices of the type that you are deleting, then all exemplars 
of this type of device will be deleted with the type of device. In this case, the program gives an additional 
warning. However, be very careful when deleting a device type. 

Specification of Variables 
Specification of variables is created based on the device type memory card. The memory card is 

a text file of special format. Memory cards are located in Devmaps folder, which in turn is located in the 
folder where the program was installed. By default, this folder is C: \Program Files\TERA\LoggerSoft. 

Specification of variables is presented in tabular format (Figure 54). Each row corresponds to one 
variable from the memory card. The table contains the Display Name, Internal Name, Data Type, 
Dimension, and Permissions columns which can be edited.  

The Display Name column is the text that will be used as the name of logical parameters when 
creating a template. To change the display name of the variable, left double-click on the interested cell. 
The cell will display the input field. Make changes and press Enter to save changes to the database, or 
press Esc to undo the changes. 

The Internal Name column indicates the original name of the variable in the memory card. 
The Data Type column indicates the data type of the variable.  
The Dimension column contains the variable dimension.  
The Permissions column contains permissions for the specified variable. 
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Figure 54. List of variables for device type 
 
Each device type must correspond to a number of key variables that are used by the program to 

synchronize time and reading/writing of a text label. For this purpose there is the Use of variables... 
button at the bottom of the dialog box. The inscription about the current state of the settings is located 
near the button. If all the key variables are set, the inscription is as follows: OK. All necessary settings 
are specified. If the key variables are not set, the inscription will be the following: WARNING! You must 
specify the assignment of variables! 

Click this button to open the Settings for devices dialog box (see Figure 55). 
 

 
Figure 55. Settings for devices 

 
In this dialog specify a variable for a text label, date and time, time zone, as well as a variable 

that is responsible for setting the automatic transition to summer time. If the device does not support 
setting of time zone, check the Device does not support time zone checkbox. If the device does not 
support the time in the 6-byte format, check the Device does not support the transfer time in a 6-byte 
format checkbox. 
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For selection of variable use the dialog drop-down lists which contain all the variables of this type 
of device. 

The OK button closes the dialog box and saves your changes. The Cancel button closes the 
dialog box without saving changes. 

Template 
The template is also represented as a table (Figure 56). Each row represents the logical 

parameter of this type of devices. The first three columns can be edited. They are Display Name, Units 
and Logged The last four columns are read only. These columns contain information about the variable, 
on the base of which the parameter was created. They are: Variable Name, Index, Data Type and 
Permissions. 

Figure 56. Template of device type  
 
The Display Name column is the text that will be used as the name of the logical parameter 

when creating an exemplar of the device template. To make changes to this column, left double-click on 
the interested cell. The cell will display the input field. Make changes and press Enter to save changes 
to the database, or press Esc to undo the changes.  

In the Units column specify the units for the parameters that are recorded by the device. This 
information is used by the program when displaying the recorded data. Each cell in this column has a 
drop-down list of all known program units (please refer to Units). 

The Recorded column indicates if a parameter is recorded or not. For this purpose, a dropdown 
list is built in the cells of the column. This information is used by the program when displaying the 
recorded data. When the template is created and the device is connected, this feature is automatically 
installed, but there may be situations in which it should be done manually. 

NOTE. Remember when each new device is connected, the list of logical parameters is created 
according to the template of this type of devices. Therefore, it is important that the template has been 
fully configured and contained no errors. 

List of device logical parameters 

Each data logger in the database has a list of logical parameters that were created according the 
template during the first synchronization with the database of the current data logger. After the logical 
parameters were created, they can be changed. In most cases, it is not required, but still there are times 
when it must be done. 

To change the settings of logical parameters, use the List of Logical Parameters command in 
the context menu of data logger (please refer to Data Logger Context Menu). As a result, the dialog 
box with the logical parameters of data logger will appear (Figure 57). 
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Figure 57. Data Logger Logical Parameters  
 
The window with a list of logical parameters of a particular data logger is very similar to the 

window with the template logical parameters (please refer to Template). It displays the same 
information, and parameters are edited in the same way. But the difference is that this window displays 
the logical parameters of the particular device, rather than the logical parameters of the template for a 
device type. 
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Logger Configuration 

Data Logger Series 

The LoggerSoft software supports LT and DLT series data loggers.  
Since data loggers of different series have different settings, and the program uses various 

dialogs to set them up. In addition, some of the functions that are available in the DLT series data 
loggers are not available to LT series data loggers. 

Time Synchronization  

Data logger time can be synchronized with computer time both on-demand programs while 
searching a data logger (please refer to Search for Connected Devices) and at any time by clicking 
Time Synchronization in the Connected Devices main menu or data logger context menu (please 
refer to Connected Devices Menu and Data Logger Context Menu). Time can be also synchronized 
by pressing the button on the configuration dialog of the data logger. 

The process of time synchronization is displayed in the window of the program Log and in the 
status bar. 

Changing a Text Label 

A data logger text label serves to illustrate the functional purpose of the data logger at the 
moment. This is an electronic equivalent of a label or a tag. Since the logger functionality may change 
over time, and then the text label can also be changed. 

A text label is changed in the Changing Label dialog box (Figure 58). To open this dialog box, 
press the corresponding button on the dialog box of the data logger settings (please refer to Logging 
Page of the corresponding data logger series. 

 

 
Figure 58. Changing Label 

 
New label can be entered from the keyboard or selected from the list. The drop-down list shows 

all text labels, which are in the database at the moment. 
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To change the label of the data logger, click OK. As a result, the dialog box will close and a new 
label will be recorded to the data logger. The program will inform the results of recording with a 
message. Details of the operation can be found in the program Log. 

Click Cancel to close the dialog box without recording the text label to the data logger. 

Changing the Metrological Certificate 

NOTE. Function of data storage about metrological certificate is only available for DLT series 
data loggers.  

DLT series data loggers store information about metrological certificate in their non-volatile 
memory. Metrological certificate is specified in the LoggerSoft program. The information includes the 
certificate number and its expiration date. 

Information about the data logger metrological certificate is entered in the Data Logger's 
Metrological Certificate dialog box (Figure 59). To open this dialog box, press the corresponding button 
on the dialog box of the data logger settings (please refer to Logging Tab). 

 

 
Figure 59. Data Logger's Metrological Certificate 

 
In the Certificate Number field specify the number of existing metrological certificate of the data 

logger. 
In the Valid to field specify the date of the next verification of the data logger. 
Click OK to record this information to the logger. The dialog box will be closed. The program will 

inform about the results of recording with a message. Details of the operation can be found in the 
program Log. 

Click Cancel to close the dialog box without recording information to the data logger. 

Changing the Logging Period 

Logging period is the time interval after which the logger saves the sensor readings in the internal 
nonvolatile memory. 

Logging period is changed during the logger set up (please refer to Data Logger Configuration). 
A new period is chosen in the Set Logging Period dialog box, an example of which is shown in Figure 
60. To open this dialog, press the corresponding button on the dialog box of the data logger settings. 
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Figure 60. Set Logging Period 

 
The New logging period field contains important information about the data logger, which 

depends on the selected logging period. 
The Filling memory in field displays the estimated time of data logger complete memory at a 

specified logging period. 
The Battery type field indicates the type of battery that uses the data logger. If the battery type is 

unknown, this field will display the text: 0. This type is not supported.  
The Replace the battery in field displays the predicted operating time period of data logger at 

the specified logging period. The predicted operating time is specified for the three ambient 
temperatures. Two of them are fixed at values of 25 ° C and -20 ° C. And another temperature can be 
set in the appropriate field. 

WARNING! Data logger operation depends on the ambient temperature, since at low 
temperatures the battery capacity reduces. Therefore, during the data logger configuration note the 
predicted time to replace the battery. Specify the temperature at which it is intended to use the data 
logger. If the data logger is supposed to be used in a certain temperature range, it is necessary to 
specify the lowest temperature in this range. If the predicted operating time at the temperature at which 
the data logger is supposed to be used, is comparable or less than the time at which the data logger is 
supposed to be used, the data logger cannot be used. Should either increase the logging period, or 
replace the battery. 

NOTE. The function of predicted operating time is only available for the DLT series data loggers.  
To save changes, click OK. To close the dialog box without saving changes, click Cancel. 

Setting Up the LT Series Data Loggers 

To configure the data logger, use the Connected Devices -> Setup... command in the main 
menu or in the data logger context menu (please refer to Connected Devices Menu and Data Logger 
Context Menu). The Settings of Data Logger dialog box will appear (Figure 61). 

The title of the dialog box contains the serial number of the data logger which is to be configured.  
The dialog box contains 5 tabs. Two of them have fixed names. They are Logging and Delayed 

Start. Other three tabs correspond to the measuring channels of the data logger and their names 
correspond to the names of logical parameters, which in turn correspond to the particular measuring 
channel of the data logger (please refer to List of device logical parameters). 

If the login is made on behalf of the user who has the rights to perform the factory settings, the 
Factory Settings tab will be also available in the dialog box. 

Clicking on the Read button will read the current settings from the data logger.   
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The Apply button is used to record new settings to the data logger. 
The Close button closes the dialog box. 

Logging Tab 
The Logging tab contains settings that relate to the logging process (Figure 61). 
The Logger time field displays the current logger time. The Synchronize button is located next 

to it. If there is a need, press the button to synchronize data logger time with the computer time. 
The Label field shows the current text label of this data logger. To change it, click the Change... 

button next to the field. As a result, the Change Label dialog box will appear. The example of the dialog 
is shown in Figure 58 (please refer to Changing a Text Label). 

The Logging period field indicates the current logging period of the data logger. To change the 
logging period, click the Change... button next to the field. As a result, the Set Logging Period dialog 
box will open. The example of the dialog is shown in Figure 60 (please refer to Changing the Logging 
Period). 

The Filling memory in field displays the estimated time of data logger complete memory at a 
specified logging period. 

 
WARNING! If the complete memory time is comparable to or less than the time during which the 

logger is supposed to be used, increase the logging period. 
 

 
Figure 61. Settings of LT2 Data Logger. Logging tab 

 

Delayed Start Tab 
The Delayed Start tab contains the settings of the delayed start of a data logger (Figure 62). 
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Figure 62. Settings of LT2 Data Logger. Delayed Start Tab 

 
The Data Logger Time section shows the current time of a data logger. If there is a need to 

synchronize the data logger time with the computer time, click the Logging tab and synchronize the 
time. 

In the Logging Start Time section specify the delayed start time.  
NOTE. To activate the delayed start, specify the logging start time greater than the current device 

time. 

Measuring Channel Tabs 
The Measuring Channel tabs are identical for all data logger channels, but their contents can 

vary depending on the data logger factory settings. The tab titles correspond with the titles of logical 
parameters, which in turn correspond to a particular measuring channel of the data logger (please refer 
to List of device logical parameters). 

If the measuring channel is disabled, the tab will take the form an example of which is shown in 
Figure 63. There are no settings on the tab, as this channel is not used. 
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Figure 63. Settings of LT2 Data Logger. Measuring channel is disabled 

 
If RTD temperature sensor is set to the measuring channel, the tab will take the form an example 

of which is shown in Figure 64. 
The Sensor section specifies the type of sensor that is configured for this channel. 
The Limits of acceptable values section sets upper and lower limits of acceptable values. When 

the sensor readings are out of the specified range, the data logger will record it to the Event Log. 
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Figure 64. Settings of LT2 Data Logger. RTD Type 

 
If the sensor type of the current input is 4-20 mA current, the page will take the form an example 

of which is shown in Figure 65. 

  
Figure 65. Settings of LT2 Data Logger. Current input. 
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The Sensor and Limits of acceptable values sections set the same settings as for RTD types. 
The Units section contains a drop-down list with the measuring units and a drop-down list of 

multipliers values. List of multipliers is not available when temperature or humidity is selected as the unit 
of measurement. 

The Zooming on a scale section specifies upper and lower limits of the scale of measurement. 
Scaling is done as follows. For example, the limits of the scales are set as in Figure 65, from 0 to 100°C. 
As a result, for the 4-20 mA current input the sensor reading equal to 4 mA will be converted to 0°C and 
20 mA reading will be converted to 100°C. 

Setting Up DLT Series Data Loggers 

To configure a data logger, use the Connected Devices ->Setup… command in the main menu 
or in the context menu of the data logger (please refer to Connected Devices Menu and Data Logger 
Context Menu). The Data Logger Settings dialog box will appear (Figure 66). 

The title of the dialog box contains the serial number of the data logger which is to be configured.  
The dialog box contains several tabs. Four of them have fixed names. They are Logging, Start, 

Buttons and Report. Additionally, one tab is created for each measuring channel. In Figure 66 these are 
Temperature and Humidity tabs. As already mentioned, the number of additional tabs depends on the 
number of the data logger measuring channels. Names of additional tabs correspond to the names of 
logical parameters, which in turn correspond to the particular measuring channel of the data logger 
(please refer to List of device logical parameters). 

The Restore Default Settings button allows resetting the current settings and restoring the 
factory. Before performing this operation, the program asks for confirmation. 

Pressing Read Settings From the Logger button reads the current settings from the data 
logger. 

The Load From File button saves data logger settings previously saved to the file. 
The Save To File button saves current data logger settings to the file.  
he Stop Logging button stops the data logging and translates a data logger into a low power 

mode. This button is disabled if there is no logging process. 
The Apply button is used to write new settings to the data logger.  
The Close button closes the dialog box. 

Logging Tab 
Logging tab displays the current logger status, and also contains settings that relate to the 

logging process (Figure 66). 
The Data Logger Current State section contains information about the current state of the data 

logger. This information includes the data logger time, text label, battery capacity, data about 
metrological certificate, logging status and remaining operating time to discharge the battery at a given 
operating temperature. 

The Logger Time field displays the current logger time. The Synchronize button is located next 
to it. If there is a need, press the button to synchronize data logger time with the computer time. 

The Label field shows the current text label of this data logger. To change it, click the Change... 
button next to the field. As a result, the Change Label dialog box will appear. The example of the dialog 
is shown in Figure 58 (please refer to Changing a Text Label). 

The Battery Capacity, mAh field contains the remaining battery capacity at 25°C. 
The Metrological Certificate field shows the number and duration of the metrological certificate 

for this data logger. To change information about the certificate, press the ... button.  The Data Logger's 
Metrological Certificate dialog box will appear. The example of the dialog is shown in Figure 59 (please 
refer to Changing the Metrological Certificate). 

There is a field of the data logger current status under the metrological certificate field. This field 
displays in bold remaining operating time of battery life at a given operating temperature, as well as the 
current operating mode of the data logger. 
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Figure 66. Settings of Data Logger. Logging tab 

 
The Logging Settings contains settings that relate to the data logging. 
The Logging mode field displays the mode in which the logger should perform logging. The 

mode is selected using the drop-down list. In the list, there are two modes: Cyclically and Till the 
memory full. 

In the Cyclically mode a data logger will record continuously. After filling all the memory, the 
oldest data will be overwritten with a new one. 

In the Till the memory full mode a data logger will record since the start of logging (please refer 
to Start Tab) and fill up all the memory. After filling all the memory, the logging process will be stopped. 

The Logging period field specifies the current logging period of the data logger. To change the 
logging period, click the Change... button next to the field. The Set Logging Period dialog box will 
appear. The example of the dialog is shown in Figure 60 (please refer to Changing the Logging 
Period). 

The Operating temperature field indicates the ambient temperature at which it is expected to 
operate the data logger. The program automatically calculates a predicted time to discharge the battery 
at the same temperature. 

WARNING! The data logger operation depends on the ambient temperature, since at low 
temperatures the battery capacity reduces. Therefore, during data logger configuration pay attention to 
the predicted operating time to replace the battery. In the Operating temperature field specify the 
temperature at which the data logger is supposed to be used. If the data logger is supposed to be used 
in a certain temperature range, it is necessary to indicate the lowest temperature in this range. If the 



LoggerSoft 55 

predicted time of the data logger at the operating temperature is comparable or less than the time during 
which the data logger is supposed to be used, the data logger cannot be used. Should either increase 
the logging period, or replace the battery. 

The When logging period... section contains important information about the data logger. The 
information depends on the logging period. 

The Filling memory in field displays the estimated time of data logger complete memory at a 
specified logging period. 

WARNING! If the complete memory time is comparable or less than the time during which the 
data logger is supposed to be used, increase the logging period. 

The Battery type field indicates the type of battery that uses the data logger. If the battery type is 
unknown, this field will display the text: 0. This type is not supported. 

The Replace the battery in field displays the predicted operating time period of data logger at 
the specified logging period. The predicted operating time is specified for the two ambient temperatures: 
25°C and -20°C. 

WARNING! The predicted operating time is estimated and may not be accurate. 

Start Tab 
The Start tab contains settings that relate to the start of logging process (Figure 67). 
In the Start Mode field specify a start mode of the logging process. This field is represented as a 

drop-down list. There are three options in the list: After setting up, By pressing the button and At the 
specified time. 

When selecting After setting up, the logger will start logging as soon as the new settings will be 
written to it. For this mode, it is possible to set the delay start. 

When selecting By pressing the button, click the button on the data logger to start the logging 
process. For this mode, it is possible to set the delay start. 

When selecting At the specified time, the logging process will automatically start at the specified 
time. This time is set on the same tab in the Logging start time field. 

In the Start Delay field specify a start delay, which is valid for After the specified time and By 
pressing the button modes. If the delay is set, the logging will not begin immediately after setting up or 
pressing the button, but only after the delay time after when the relevant event occurs. To set the start 
delay, enter an integer numeric value and select the units in which the delay is measured. To select the 
delay unit, use a drop-down list. The list includes the following units: seconds, minutes, hours and days. 
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Figure 67. Settings of Data Logger. Start tab 

 
The Alarm State After Logging Start contains settings of alarm start. 
In the Alarm field specify the initial state of alarm after the logging start. To select the initial state, 

use the drop-down list. The list has two states: ON and OFF. 
If OFF is selected, the data logger will record the sensor readings, but will not control them. 
If ON is selected, the data logger will record and control the sensor readings. 
During the operation of data logger, switch it from the OFF to ON and vice versa using the button, 

if it is allowed in the settings (please refer to Buttons tab). 
To switch to ON mode, the delay can be set. The delay is specified in the Alarm Delay field. To 

set the delay, enter an integer numeric value and select the units in which the delay is measured. To 
select the delay unit, use a drop-down list. The list includes the following units: seconds, minutes, hours 
and days. If the delay is set, the data logger status will be ON not immediately after pressing, but only 
after the delay time. 

Buttons Tab 
The Buttons tab contains settings for data logger buttons (Figure 68).  
The settings are in the Button Functions section, and the description of the current settings is in 

the Hint section. 
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Figure 68. Settings of Data Logger. Buttons tab 

 
In the Allowed Actions field set the limitation of actions that can be performed using the data 

logger buttons. The field is designed as a drop-down list. The list contains the following options: Only 
indication, Only start, Only one delivery and No limits. 

If Display only is selected, it is only possible to indicate the data logger current state and the 
results of transporting cargo using the buttons. Other actions will be blocked. 

If Only start is selected, apart from the indication, it is possible to start the logging process using 
the buttons. Other actions will be blocked. 

If Only one delivery is selected, apart from the indication and logging process start, the function 
of switching the alarm state modes will be available. But at the same time, the alarm can be switched on 
only once. 

If No limits is selected, any action is available using the buttons. They are indication of the 
current logger state and transportation results, the logging process start, switching the alarm state 
unlimited number of times. 

Report Tab 
The Report Tab contains settings for parameters of a report which is generated when the data 

logger is connected to the computer in the Flash Drive mode (Figure 69). 
The Report Language section allows to specify the language in which the report will be formed. 

By default, the data logger forms a report in Russian. The list of available languages is in the drop-down 
list which depends on the firmware of the specific data logger. 
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Figure 69. Settings of Data Logger. Report tab 

 
The Report Format field specifies the file format for a report. The field has a drop-down list which 

contains the following variants: Text File With Delimiters (*.CSV)1 and PDF File (*.PDF). This field may 
be inactive depending on the firmware of the specific data logger.  

The Report Period field specified the period for which the report should be generated. The field 
has a drop-down list which contains the following variants: Since logging starts and Last alarm 
session. In the first case, the report will be created from the logging start till the report generation, i.e. all 
accumulated data. In the second case, the report will be created from the last time the alarm was turned 
on till the time it was turned off or till the report generation, if the alarm has not been turned off yet. 

Measuring Channel Tabs 
Measuring channels tabs (Figure 70 - Figure 72) are identical for all data logger channels. Tab 

names correspond to the names of logical parameters, which in turn correspond to a particular 
measuring channel of the data logger (please refer to List of device logical parameters). 

The Units of Measurement section contains fields for setting measuring units and multiplier 
values of the channel. Both fields are designed as drop-down lists. The contents of the fields depend on 
the firmware of the specified data logger. 

                                                 
1 CSV (Comma-Separated Values) — text format for presenting tabular data. Each file line is one row of the table. Values of 
separate columns are separated by delimiters.  
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The Sensor Settings section contains two buttons for settings of the current measuring channel.   
The Sensor Settings button opens the Settings of the Channel dialog box (Figure 73 and Sensor 
Settings Dialog Box).  

If the user with the rights to perform the factory setting logged into the program, the Factory 
settings... button will also be available on the dialog box. Clicking on this button opens a dialog box of 
factory settings of the current measuring channel.  

Tab view depends on the selected option of alarm conditions. It is selected using the drop-down 
list in the Alarm Conditions field. The drop-down list has three options: Do not process, 
Minimum/Maximum and Multilevel. Alarm condition is the criterion by which the data logger will 
evaluate the result of cargo transportation. 

If Do not process is selected, the tab will take the form shown in Figure 70. The data logger will 
only record the readings of the measuring channel without checking the value of these readings.  

 

 
Figure 70. Measuring Channel Tab. Alarm conditions are not set.  

 
If Minimum/Maximum is selected, the tab will take the form shown in Figure 71. 
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Figure 71. Measuring Channel Tab. Minimum/Maximum 

 
The Minimum/Maximum section indicates the upper and lower limits of acceptable values for 

this channel. If limits are violated, the data logger will record the relevant events in the Log, and 
accumulate statistics. These statistics will be used later to form the results of cargo transportation. 

In the Alarm Delay field specify the alarm delay when the limits of permissible values are 
violated. Delay works as follows. If the limit is violated for a time greater than the delay, the alarm will be 
triggered and the result of cargo transportation will be negative. If the channel reading returns within the 
acceptable values earlier than the time runs out delay, the alarm won’t be triggered and the result of 
cargo transportation will be positive. To set the alarm delay, enter an integer numeric value and select 
the unit in which the delay is measured. To select the delay unit, use a drop-down list. The list includes 
the following units: seconds, minutes, hours and days. 

NOTE. This delay is valid for separate upper and lower limits of permissible values. 
In the Delay Type field choose the following options in the drop-down list: For each violation 

and Total for all violations. If For each violation is selected, the alarm delay works for each violation 
of the limit. I.e. after the reading is returned within the acceptable limits, the used delay time will be 
zeroed.  

If Total for all violations is selected, the alarm delay is applied to all limit violations as follows. 
Time for which the limit was violated is subtracted from the remaining alarm delay time. As a result, if the 
total time of all violations exceeds the alarm delay time, the result of cargo transportation will be 
negative. If the total time of all violations does not exceed the alarm delay time, the result of cargo 
transportation will be positive.  
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The Hint section displays information about the selected delay type. 
If Multilevel is selected in the Alarm Conditions field, the tab will take the form shown in 

Figure 72. 

 
Figure 72. Measuring Channel Tab. Multilevel alarms.  

 
Multilevel alarm mode splits the alarm condition into 6 independent zones. Zone 1 represents the 

range of highest values. Zone 6 is the range of minimum values and Zone 4 is the range of acceptable 
values. The following parameters are specified for each zone: limits, delay time, delay type and 
permissible number of violations. While inspecting the cargo transportation, the data logger will analyze 
the statistics for each zone separately and if the alarm is triggered at least in one area, the result of 
cargo transportation will be negative. If there is no alarm in any area, the result of cargo transportation 
will be positive. 

Zone limits are specified in the fields located at the intersection of areas. 
To set the delay, enter an integer numeric value in the Delay field and select the delay unit using 

a drop-down list. The list includes the following units: seconds, minutes, hours and days. 
In the Delay Type field choose the following options in the drop-down list: For each violation 

and Total for all violations. Processing of delay type is similar to the processing of delay type in the 
Minimum/Maximum alarm mode (see above). 

In the Violation field set the allowable number of limit violations. This setting is independent of 
the alarm delay. If the zone limit is broken more times than specified in the field, this zone will trigger an 
alarm, regardless of whether delay time out or not. 
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If there is no need in all zones, Zone 1, Zone 2 and Zone 6 can be turned off. To do this, 
uncheck the corresponding zone. 

Zone 3+5 coupled can extend the zone of permissible values. If this checkbox is checked, the 
zone of acceptable values includes Zone 3, Zone 4 and Zone 5.  

Sensor Settings Dialog Box 
The Sensor Settings dialog box is presented on the Figure 73. 
The Sensor section contains Sensor Type field. The field is designed as a drop-down list. The 

list contents and its availability depend on the specified data logger and the measurement channel. 
The Correction section includes Incline and Offset fields. These are coefficients which are used 

to correct the deviation of the sensor from the sample. These fields are available depending on the data 
logger and measurement channel.  

 
Figure 73. Settings of the channel  

 
The Zooming on a scale section contains The upper limit of scale and The lower limit of 

scale fields which are used to scale the values of analog sensors. These fields are available depending 
on the data logger, measurement channel and sensor type.  

Replacing the Battery 

NOTE. Function of battery replacement is only available for DLT series data loggers. 
This operation should be performed after the battery is physically replaced in the data logger. The 

operation is necessary for the correct prediction of the remaining data logger time.  
WARNING! Be extremely careful when choosing and replacing the battery. In case of error, 

the prediction of the remaining data logger time will be unreliable. 
For battery replacement use the Battery Replacement... command in the Connected Devices 

main menu or data logger context menu (please refer to Connected Devices Menu and Data Logger 
Context Menu). The Battery Replacement dialog box will open (Figure 74). 
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Figure 74. Battery  Replacement 

 
The dialog box contains the serial number of the data logger and the expected type of battery. 

Enter the capacity of new battery and click OK to perform the operation, or Cancel to close the dialog 
box without performing the operation. 

WARNING! If the battery of another type is inserted to the data logger, the prediction of the 
remaining data logger time will be unreliable. 

WARNING! If the capacity of a new battery will be more than factual, the prediction of the 
remaining data logger time will be unreliable. 

Clock Calibration 

Note. The clock calibration is available only for DLT series data loggers.  
To calibrate the data logger clock, it is necessary to enter the program as the user with the right 

to run the factory settings.  
Then use the Clock calibration command in the Connected Devices main menu or data logger 

context menu (please refer to Connected Devices Menu and Data Logger Context Menu). The Clock 
calibration of the logger dialog box will open (Figure 75). 

 

  
Figure 75. Clock calibration of the logger 

 
Enter the calibration frequency in the field and click the Calibrate button to calibrate a data logger 

or Cancel to close the window without calibration.  
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